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System waivwmw\-l's for V8.1

THESE ARE MINIMUMS ONLY

->Windows 10, Windows 8.1 or Windows 7
32-bit or 64-bit editions, with latest updates and service packs

= Intel Core 13/5/7 or AMD Athlon 64 (faster processor)
-4 GB RAM

—>»80 GB hard disk space (free space: 40 GB)

—>1366 X 768 screen resolution

—>Microsoft Internet Explorer 11 or later

—>Microsoft .NET Framework 4.6

_..=>Internet connection. s made 4o otz BERININA
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Automatic UPAM'Q/

—>When update is available, this is the
screen you see:

Update Available

e

Click here to view

An update from V&.0K to V8.0T is ava

the details, ..

Yesg

Would you like to download and install it?

Mo

ilable,

Remind me: |Mext Time

=

Who needs the update?

* \Version 8 OK
* Version 8 OM
* Version 8 OR
* Version 8 0S
* Version 8 OT
* Version 8 0T R1
* Version 8 OT R2
(June/Sept)
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What 4o do priov to update

—>Remove Corel Essentials X4, delete Corel X4 folder
->Windows operating system must be up to date
—>User must have administrator rights

—>Security settings of browser must be set to medium-
high (Windows 7: Use Internet Explorer 11)

—>Edge: Change cookie settings in Windows 10 OS
—>Internet connection is required during the installation

-=Turn off anti-virus and firewall to connect to Wilcom’s
server for the download
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How to Delete Corvel X4

—~Control Panel

—~Programs & Features

—Select CorelDRAW Essentials 4

SUninstall @ coeomw e Corel Corporation o/7/2015

—~Locate Corel X4 folder in Program Files
(X86) and delete  |esms e rmmrem ) ody

7 Open Include in library = Share with - Burr

Mame

Corel PaintShop Pro X9
CorelDRAW Essentials 4
CorelDRAW Essentials X

6



Windows is Up-h-'bwl'w

—If your automatic updates are turned off,
turn them on and install any Windows
updates

—Adobe Reader must be up-to-date—
Version 17.012.20098

Uninstall or change a program

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

Organize - = =
Mame : Publisher Installed On  Size Version
B8 2dobe Acrobat Reader DC Adobe Systems Incorporated 8/31/2017 253 MB 17.012.20098
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Administvator RigH’s

=Control Panel> User Accounts

Adjust your computer's settings View by: Large icons ¥

&)

a B

@ ®

7 (@

y

Action Center

Credential Manager

Dell Command | Update

Performance Information
and Tools

Recovery

Sync Center

Windows Anytime
Upgrade

P windows Update

Administrative Tools

Date and Time

U Dell Touchpad

g Personalization
Q Region and Language
&Y System

‘t_;] Windows CardSpace

AutoPlay

Default Programs

Desktop Gadgets

Phone and Modem

RemoteApp and Desktop
Connections

Taskbar and Start Menu

Windows Defender

a& Backup and Restore

Dell Audio

Device Manager

@ f0

Power Options

Sound

)
e/

Troubleshooting

Windows Firewall

& &

Color Management

Dell Command | Power
Manager

Devices and Printers

Display f@'\ Ease of Access Center Flash Player (32-bit) ] Folder Options h Fonts
@ Free Fall Data Protection _'[ Getting Started HomeGroup a;{, Indexing Options Intel® HD Graphics
~ Intel® Rapid Storage . p, . o [5; Location and Other
@ Technology Internet Options & | Java (32-bit) &> Keyboard E‘jﬁ" Sensors
@ Mail (32-bit) Mouse é"l,' Network and Sharing Notification Area Icons %, Parental Controls
== Center 33

Programs and Features
Speech Recognition
User Accounts

Windows Mobility Center




Changing Account

—>If you are not the administrator, click on

Change your account type

Make changes to your user account

Create a password for your account

Change your picture

2

Hg_#tiange your account nam

f’;' Manage ancther account

E‘;' Change User Account Control settings

dlashbrook

Administrator

made to creale BERNINA



Select Administrator

—~>Change from standard to administrator

Select your new account type

dlashbrook

Administrator

(7 Standard user

Standard account users can use most software and change system settings that do not affect other users or
T omputer,

@ Adrinistrator
Adrministrators have plete access to the cormputer and can make any desired changes. Based on
notification settwrds, administrators may be asked to provide their password or confirmation before
ing changes that affect other users,

We recommend that you protect every account with a strong password,

made to creale BERNINA




Intevnet Exploww

—>Open Internet Explorer

=>Turn on Menu first (in upper right corner)
- Right click on Tools icon m@)

- Make sure Menu Bar is checked

OCCOCCOOCOCCOOOOOCOOOCOCTCOOOOCCOOCOOTCOCOOOCOOCOOOOOOL

(E

— o -Wu

Menu bar
{!\th l/_[:-?‘/
Comman d bar
Status bar
v Snagit
Google Toolbar
PDOF Architect 5 Toclbar

Lock the toolbars

v Show tabs on a separate row

made to creale BERNINA




Intevnet Exploww Vevsion 11

-Help Menu> About to check ™

Internet Explorer Help F1

Ve rS I O n ‘-;:“a: iﬂuzu:;r:tlntemet Explorer 11
—~>Download If necessary

T2l 1ML
e Internet
Explorer

Version: 11.0.9600.18792

Update Versions: 11.0.46 (KB4036586)
| Product ID: 00150-20000-00003-AA459

About Internet Explorer

5

® [¥] Install new versions automatically

© 2013 Microsoft Corporation. All rights reserved.

Close

made to ceatz BIEIRININA




Select Intevnet 0|>+ior\s

—Select Tools

—Select Internet
Options

File

Edit View Favorites Help

x (&2 Snagit E =y Delete browsing history... Ctrl+Shift+Del

L

InPrivate Browsing Ctrl+Shift+P
Turn on Tracking Protection

ActiveX Filtering

Fix connection problems...

Reopen last browsing session

Add site to Start menu

o | View downloads Ctrl+)
Pop-up Blocker »
SmartScreen Filter »

Manage add-ons
Compatibility View settings

Subscribe to this feed...
Feed discovery *

Windows Update

Performance dashboard Ctrl+Shift+U
F12 Developer Tools

' ' ; Website problem
' 2 ' | Internet options
t-a W] i

/
made 1o etz BBEIRININA



Rwst'ing Intevnet Exp‘onw

[
| General | Security I Privacy I Content | Connections | Pro{_kams | Advanced [
3 \ "

—=Select Advanced Tab
-é S e I e Ct R e S et SEtﬁngs Enable Integrated Windows Authentication® 7 -

3 Enable native XMLHTTF support
[] Enable Smartscreen Filter
[] Enable strict P3P validation™®
Send Do Mot Track requests to sites you visit in Internet E
[] usessL 20
[] usessL 30
Use TLS 1.0
Use TLS 1.1
E Use TLS 1.2
Warn about certificate address mismatch™ |
[] warn if changing between secure and not secure mode =
Warn if POST submittal is redirected to a zone that does nl—

-

4| 1] [ 3

*Takes effect after you restart your computer

Restore advanced settings ]

Reset Internet Explorer settings

Resets Internet Explorer's settings to their defaul
condition,

You should only use this if vaur browser is in an unusa tate.




Rwst'ing Intevnet Exploww

%Select Reset {Heset —— Explm_er Settings T__, - . g

! _ Are you sure you want to reset all Internet Explorer

settings?

Resetting indudes:

* Disable toolbars and add-ons *  Advanced options

+ Default web browser settings + Tabbed browsing settings
+ Privacy settings + Pop-up settings

*  Security settings

["] Delete personal settings
Rezets home pages, search providers and Accelerators to default
settings. Deletes temporary Internet files, history, cookies, web form
infarmation, ActiveX Filtering data, Tradking Protection data, Do Mot
Track data, and passwords.

You must restart your computer for these changes to take effect.

How does resetting affect my computer? @ Cancel
[

made to ceatz BIEIRININA




Check Secuvity: N\Q/A-“igb\

Internet Options L ? X

—%O p e n I n te rn et EX p I O re r | General | Security | Privacy | Content | Connections | Programs | Advanced |

-Select Tools> Internet @ & v ®
Options> Security tab

Internet
@ This zone is for Internet websites,

except those listed in trusted and
d . . h restricted zones.,
E Set to M e I u I I l I I Ig Security level for this zone

Allowed | iezgne: Medium to High
—Click OK

- Appropriate for Jnost websites

- Prompts befope downloading potentially unsafe
content

- Unsigned ActiveX controls will not be downloaded

Ln

m
1]

Enable Protected Mode (requires restarting Internet Explorer)

Custom lewvel... Default level
Reset all zones to default leve




Changing Cookie Settings

—->Windows 10

SBERNINA V8 activation - N >
will not be able to proceed
If cookies are blocked

—>Search bar: Type Internet
Options

—Select Internet Options
(Control Panel)

€ Block or allow pop-ups
Search suggestions

£ internet options - Ses web results
internet options google

internet options australia

internet options windows 10

internet options telstra

t
t
t
t

internet options perth
t

internet options sydney
It

W o v v v v ©

internet options windows

G P internet options

17



Changing Crookie Settings

—Select the Privacy Tab
—Click the Advanced Button

.Y Internet Properties ? x
General Sev:urintent Connections Programs Advanced
Settings
Sites Advanced
Location
ever allow websites to request your :
M I bsites to t Clear Sites
physical location
Pop-up Blocker
Turn on Pop-up Blocker Settings
InPrivate

Disable toolbars and extensions when InPrivate Browsing starts

18



Changing Crookie Settings

%Acce pt COO kles € Advanced Privacy Settings e

E_ You can choose how cookies are handled.
—~Check Always allow =
session cookies Frapaty Cooies _Thipary Coake

%CIICk OK DPF:';D’E ( Prompt

] Cancel

19



Tarn off Windows Defender

indows Fivewall

=>Control Panel> Windows Firewall &
Windows Defender

m' ﬁ ¥ Control Panel »

Control Panel Home

Allow a program or feature
through Windows Firewall

'E‘:;f' Chan

'EE' R defaults —/

'E':;f' Advanced settings

Troubleshoot my network

Turn Windows Firewall on or
i ¢

Customize settings for each type of network
You can modify the firewall settings for each type of network location that you use,
What are network locations?
Home or work (private) network location settings
&_I 1 Turn on Windows Firewall
- Block all incorning connections, including those in the list of allowed programs

Windows Firewall blocks a new program

@_l @ Turn off Windows Figéwall (not recommended]

Mnrkluc Bn settings

&_I 71 Turn on Windows Firewall

Block all incorning connections, including those in the list of allowed programs

n Windows Firewall blocks a new program




Other Virus Protection

—>Some programs-- you can right click
and turn off through disable

—Others, must open to turn off

—If asked for how long?
- Turn off permanently until updated
- Turn back on after complete update

Open Symantec Endpoint Protection
Disable Symantec Endpoint Protection

................................................................................................. made to creale BERNINA




nginning +he UPAM'Q/

Bernina_V8.0T_R2_Update.exe
Open

% Run [35 administrator
Troubleshoot compatibility
Pin to Start

Scan for Viruses...
Share
Pin to taskbar

[

Restore previous versions

Send to >

Cut
Copy

Create shortcut
Delete

Rename

Properties

OOOOOOOOOOOOOOOOOOCOOOOOOOOCOOOOOOOOCOOOOOOOOCOOOOOOOOOOOOOOOOOOOOOOOOOOOCOOOOOOOOCOOOOOOOOCOOO00 ma& +o a\eaE BEHN I NA
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No Intevnet Connection

BERNINA Embroidery Software 8 - InstallShield Wizard

0
&3

Preparing Setup
Please wait while the InstallShield Wizard prepares the setup.

R AIASH AN AN NN AN

rosessiasiisinesnes Made To creale

BERNINA

BERNINA Embroidery Software 8 Setup is preparing the InstallShield Wizard, which will guide
you through the rest of the setup process. Please wait.

Internet Connection Required

/ and activation of BERNINA Embroidery Software 8.

Please check your Internet connection and try again.

"‘xl An active Internet connection is required for installation, registration

Cancel

More BERNINA tips and tools at:
www.bernina.com/V8

made to ceatz BIEIRININA



Installation Stavts

—Microsoft Net  sivs = &
Framework 4.6  “zziise

Flease wait while the .MET Framewaork is being installed.

File security verification:

All files were verified successfully.

Installation progress:

Installing .MET Framework 4.6
X

"". This file does not have a program associated with it for performing this action. Please install a
- program or, if one is already installed, create an association in the Default Programs control
panel.

L Cancel
made to ceatz BIEIRININA




Installation Process

—>Security Device Drivers

| BERNINA Embroidery So

Preparing Setup
Please wait while the InstallShield Wizard prepares the setup.

(TRIIOTIIVIVITOIIIOIINOEPEOIRINIEIININIL ORI ORVRORISCRG ||V, V- |2 ¢ o caea.ti BER N I NA

BERNINA Embroidery Software 8 Setup is preparing the InstallShield Wizard, which will quide
you through the rest of the setup process. Please wait.

5 @ Installing Security Device Drivers. Please wait...

b P _‘**..b p
Unlimited Creativity

?

More BERNINA tips and tools at:
www.bernina.com/V8

made to ceatz BIEIRININA




EULA

—~Two End User License Agreements to check

"BERNINA Embroidery Software 8 - IntalShiela Wizar

License Agreement

Please read the following license agreement carefully.

ARG COCOCIC OB DO DN,

s

BERNINA

BERNINA International AG. (BERNINA) as licensee from Wilcom
International Pty Ltd.

RIGHAARAIADDANID W\ad& to ma.E

Warning: This computer program is protected by copyright law and
International treaties. Unauthorized reproduction or distribution of this
program, or any part of it, may result in severe civil and criminal

e e e penalties and will be prosecuted to the maximum extent possible
W Ay
::"*.*:2»**, under the law. Wilcom International Pty Ltd claims Copyright © 1990-
& :** *‘%: 2017 in the software, software media, hardware or software locks and
*:*:*I any accompanying documentation provided to you (“Product”). All
i’***'**tt e rights reserved.
- Yo
r***_*"xr, TrueView and Point & Stitch are trademarks of Wilcom Pty Ltd.
,:;’** fk’i: Portions of the imaging technology of this product are copyrighted by

Unlimited Creativity

AccuSoft Corporation. The EPS File Import/Export Converter used in

this product is copyrighted by Access Softek, Inc. All rights reserved.

Brint

¢ | accept the terms of the license agreemeD

. " | do not accept the terms of the license agreement
More BERNINA tips and tools at: |

www.bernina.com/V8
| a—— =

Installshield CBack

Cancel




N\Q/VQQ/

—>To merge user files from other versions

Select a version

Select a previous version to merge with. NA
AP AP DD AN I D DA P D DA DD DD W\ad& +b mﬂté BE R N I

Select the installed version you wish to merge user-defined settings with.

" | do not wish to merge.

(" BE 6.0N - C:/Program Files (x86)/BERNINA/E mbroidery Software 6
" BE 7.0T - C:/Program Files (x86)/BERNINA/E mbroidery Software 7

Unlimite_dhCrggtivEy A

?

More BERNINA tips and tools at: |
www.bernina.com/V8 ]

<Back Nest>

made to ceatz BIEIRININA



Thivd Po\H'g Dvrivers

-=>Drivers install

0000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000

@ Installing 3rd Party drivers and software. .

made to creale BERNINA



Uninstall Covel Essentials X6

BERNINA Embroidery Software 8 - InstallShield Wizard
Obsolete Products Detected

SRR R R made o create BEERININA

Unless

X

ed for other apphcations, these products may be removed

CorelDRAW Essentials X6 (16.2)

Unlimited Creativity

More BERNINA tips and tools at
www.bernina.com/V8

< Back Newt > Cancel

made to ceatz BIEIRININA




rel lnstalls; Hhen BERNINA

BERNINA Embroidery Software 8 -

®

CoreDRAW

Graphics Suite

Initializing the Setup

Please wait ...

Setup Status

made 1o creats BBEIRRNINA

BERNINA Embroidery Software 8 is configuring your new software installation.

Installing

el
Unlimited Creativity

More BERNINA tips and tools at: l‘
www.bernina.com/V8 ]

made to ceatz BIEIRININA
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Universal Communication

T
|

BERNINA Universal Communication Server - InstallShield Wizérdw‘ re

Setup Status

The InstallShield Wizard is installing BERNINA Universal Communication Server

InstallShield

Cancel

made to ceatz BIEIRININA




estavt Computer

 BERNINA Embroidery Software 8 - InstallShield Wizard

AT

OSSO NN MDAttt IMade. To matz BE R N I NA

InstallShield Wizard Complete

The InstallShield Wizard has successfully installed EERNINA Embroidery Software 8. Before you
can use the program, you must restart your computer.

o Ve My, % Yes, | want ta restart my computer now.
Ry ot 304

" No, | will restart my computer later.

b Remove any disks from their drives, and then click Finish to complete setup.

Unlimited Creativity

?

More BERNINA tips and tools at: |
www.bernina.com/V8 !

made to ceatz BIEIRININA




Successful N\Q/sso\gw

| i ‘, BERNINA Embroidery Software 8 has been successfully installed. You
L may now run the software.

—Click OK
—>Don’t open software yet

—>Double click on Corel SE (green icon)
on Desktop




ng istev Covel

CoreDRAW (’)

Graphics Suite

Let us get to know you

CoreIDRAW (')

Graphics Suite

Let us get to know you

Signing in gives you access to online content. To sign in, create your Corel account now. If you
already have an account, enable the check box and enter your credentials in the fields

provided.

[[11 already have an account

Email

Password

Confirm Password

United States

Get critical software updates and exclusive offers.

Have your say, participate in Corel research.

Privacy policy, All information is confidential and will not be shared with any 3rd party.

Continue

Signing in gives you access to online content. To sign in, create your Corel account now. If you
already have an account, enable the check box and enter your credentials in the fields
provided.

[¥I1 already have an account

dlashbrook@berninausa.com

Password

Forgot password?

Continue




Validate coreDraw. @)

Graphics Suite

> O pe n e I I lal I Please confirm your email address
- - We emailed a confirmation link to username@gmail.com. Click the link in the email to validate
—Click on linK to

When the confirmation period of 7 days expires, you will no longer be able to launch the

validate account .
u If you are using a trial version, you must confirm your email address to access the application

for the remainder of your trial period.
Can't find the email? Click Resend Email, check your Inbox, and follow the instructions.
Email associated with your corel.com account: jhcreates@icloud.com

Change emall

Resend email

Close

made to ceatz BIEIRININA




Authenticated N\wssagw

—~>Ready to use CorelDRAW \(’))
software -

rame C
il i

You are signed in, and your product is authenticated

Your product has been authenticated using the following email:

XXX@berninausa.com

You now have access to;

o Online content such as clipart, photos, templates and pattem fills
e An online selection of fonts

e Performance and stability updates

Continue

made to ceatz BIEIRININA




Run as Administvator

Open
o~y Troubleshoot compatibility
-

—~First time you open ri-¢

Fun as administrator I}

software, right click on icon | s

PDF Architect 5

Add to archive..,

Add to "DESLOADR.rar”

Compress and email...

Compress to "DESLOADR.rar” and email
Pin to Taskbar

Pin to Start Menu

i G o i =

—Select Run as Administrator

Restore previous versions
Send to

Cut
Copy

Create shortcut
Delete

Rename

Properties

37



Link N\Q/sso\gw

—>Click Install Link

Artwork Canvas

|@ Would you like BERNINA Embroidery Software to link
with CorelDRAW Graphics Suite SE?

Install link to CorelDRAW
TS~ uire adminis T privileges.

— Do not install

Artwork Canvas will not be available.

made to ceatz BIEIRININA




Covel Not lnstalled N\wssagw

—Close the software
—~>Reboot

Error X

CorelDRAW(R) SE is not installed on this computer or is not
configured to interact with DesignerPlus.

To enable the interaction, please install CoreDRAW(R) SE and restart
DesignerPlus.

OK

made to creale BERNINA




Check Anti-Vivus

—~>Add BERNINA to exception list

@ Change Settings - Symantec Endpoint Protect; El_lﬂ

Change Settings __feo
Status | You can change the folowing settings:
Scan for Threats
| Change Settings Virus and Spyware Protection
- . Protects against viruses, malware, and spyware [;____g__c_:__n__ﬁgg_[_g___§§;;jn_g§____;‘
View Quarantine
View Logs
@H Proactive Threat Protection
LiveUpdate v Provides zero-day protection against unknown threats I Configure Settings ‘
@“ Exceptions
vi Exceptions provide the capabiity to exclude files, folders, and [ Configure Settings ‘
processes from being scanned Y

Client Management
Provides functionality to manage this client I Configure Settings

made to ceatz BIEIRININA




New Installation

made to creale BERNINA




New Installation Precautions

—~>Remove Corel Essentials X4, delete folder
->Windows must be up-to-date

—~Adobe Reader must be up-to-date
—>Administrator rights

—>Connected to Internet

—>Internet Explorer 11 must be default browser
for Windows 7; Edge for Windows 10 (accept
cookies)

= Turn off anti-virus and firewall
STy - | f © { V] [\ Y

42



New Installation of V8

REMEMBER

Organize ¥ AutoPlay Eject Properties System properties  »

- 40 Favorites 4 Hard Disk Drives (2)
B o 0S(C) HP SimpleSave (G2)
e rS I O n aS & Downloads R e : -

290 GB free of 452 GB 15 GB free of 465 GB
%/ iCloud Photos 90 GB free of 452 GB 15 GB free of 465 GB

1] Recent Places 4 Devices with Removable Stogaeg®(4)
b I aC k l ' S B =] Pictures i . CD Drive (E:) Bernina_V8 0T

e
@ DVD RW Drive (D:) 0 bytes free of 2.90 GB

o CDFS
4 Libraries
= Documents 54 FD Drivfe (F:) lf—if’_lia:;cher USB DISK (H: ‘ -
5 o/ es free of 88 ) =
n > ¥ Embroidery =y C W’ 200 GB free of 4.57 GB
> @ Music <
: 4 Other (1)
|e=| Pictures
B Videos % iCloud Photos

two drives

4 M Computer
&, os(c)
- > o4 CD Drive (E:) Bernina_V8.0T
—Select CD Drive for | femis
@) HP SimpleSave (G:)
e USB DISK (H:)

exe file

/M DLASHBROOK

CD Drive (E:) Bernina_V8.0K Space free: 0 bytes File system: CDFS
CD Drive Total size: 2.90 GB

made to ceatz BIEIRININA



Install as Admi

-Location exe file
—>Right click

-Select Install as
administrator

GO

e

istvator

J ( » Computer » USBDISK (H:) » VB1R2 »

Organize ¥ @ Open Burn New folder
% Favorites ActiveSync [ data2
B Desktop Corel 2] ISSetup.dll
& Downloads ISSetupPrerequisites || layout.bin
% | iCloud Photos LicenseTransfer
| Recent Places . Microsoft
[&5] Pictures Support Open
. User Manual Run as administrator
4 Libraries Win32 Troubleshoot compatibility
: Documents x64
20 Embroidery ] 0:0402
& Music 5 0x040c PDF Architect 5 »
=] Pictures & 00d1d B Addtoarchive...
$¥ videos | 00dle B Addto "setup.rar’
£ 00404 g Compress and email...
'% Homegroup g A0k @ Compress to "setup.rar” and email
i | 0x0407
1% Computer i+ 0x0409 Send to N
&, os(c) 4| 0x0410 Cut
5 CD Drive (E:) Bernina_V8.0K = 0ouL Copy
o4 CD Drive (F:) HP Launcher | 0x0412 = :
@) HP SimpleSave (G:) ] 0:0413 D':tt“ DHcuE
s elete
e YSB DISK (H:) & 00414
45| 0x0415 Rename
€ Network & | 00416 Properties
1% DLASHBROOK 5 0x0419
i# |autorun
|| datal
|| datal.hdr
setup Date modified: 9/11/2017 5:07 AM Date created: 9/18/2017 10:16 PM

Application

Size: 796 KB

made to ceatz BIEIRININA



Ad’iva-l'ing Software

—~Complete information
—~Be patient

—>Progress bar across
bottom

—>WiIll get a successful
message

—>Click OK

i 1

Please register and activate the software by entering the following information.
All fields are mandatory.

Product key: - - - -
Please keep the product key in a safe place. The key is needed
when re-installing the software.

First name: Debbi

\ BERMINA Embroidery Software X

= 0 The product has been successfully registered and activated.

LN

Click OK to continue running the software.

OK

Lin

Country:

Zlp:

The product has been successfully registered and activated.

0K Cancel




Check for Version

—~>Open Software
—>Help> About
->Version 8.0T R2
—Is Version 8.1

Help

Help Topics...

Reference Manual
Release Motes
Check for Updates...
About...
v | Show Design Warning
Embroidery Software 8 Product Information
Buy Software from a Dealer
Buy Designs on EMB Design Studic
Buy Designs on Embroidery Online
Watch Online Tutorials

46

About

- BERNINA
sz | Embroidery Software 8
¥: | DesignerPlus

}
f
¥
N

P S P
Unfimited Creativily

; . made o eaz BERNINA

Copyright (C) 1997-2017 Wilcom International Pty Ltd and Wilcom Pty Ltd,
Sydney Australia. All rights reserved.

>

m

TrueView, Point & Stitch and Ambience Quilting are trademarks of Wilcom Pty
Ltd.

Portions of the imaging technology of this product are copyrighted by AccuSoft
Corporation. The EPS File Import/Export Converter used in this product is

V8.0T R2 9 Oct 2017 (137-10418)
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Possible Evvor N\wssagws
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Evvor N\wssagw: Timed Out

—~>Reset Internet Explorer 11/or Cookies & try
again

—If you still get error, submit a ticket to
bernina.com/help

—Fill out form completely including Product
Key :
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HASP Evrovs: 1

—HASP Error—3 error messages
- No license found (reinstall HASP driver)

# | Security Error @

Avalid license to run BERNINA Embroidery Software could not be
found.

5
2.8 BERNINA Embroidery Software 8

Please run 'Reinstall HASP Drivers' from the Start Menu and try again,

If the problem persists, please visit wwww.wilcom.com/support for

assistance (H0007) Pu rge Recovery

Reinstall HASP Drivers

OK

Report an Issue

Revert
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Resta rting Sevvice

=Control Panel> Administrative Tools> Services

I' .. Services I L) 1 [-:"EI'E1
-

L]
AS e ntl n e I File Action View Help
e D Ec=zHE > o nw®
| L Services (Local) © ' Services (Local)
. .
A R I qt C I I C k Sentinel LDK License Manager Name Description Status Startup Type Log On As -
g % Remote Procedur... TheRPCS5.. Started Automatic Network Service
Stop the service: % Remote Procedur...  In Windows... Manual Network Service
Restart the service
., Remote Registry Enables rem... Manual Local Service
AStO D 1St L Routing and Rem...  Offers routi... Disabled Local System
DESUiFtiU'f“ . L+ RPC Endpoint Ma... Resolves RP... Started Automatic Network Service
EBEEEQESIICEHSES secured by Sentinel i Secondary Logon  Enables star.. Manual Local System
G Secure Socket Tun... Provides su.. Manual Local Service

A r Lo Security Accounts.. Thestartup ... Started Automatic Local System
o Searrty e - V... Started Automatic (0. Local Service

Manages Se.. \tarted Autemnatic Local System

Manages lic.. tarted Automies
—PTovides ru...  Started Autom Stop
G Server Supports fil..  Started Autom Pause
L Shell Hardware De... Provides no..  Started Autom T |E
L Skype Updater Enables the ... Autom Retart
Lo Smart Card Manages ac... Manua
L5 Smart Card Remo... Allows the s... Manua All Tasks >
L5 SNMP Trap Receives tra... Manua -
‘.-, Software Protection Enables the ... Autom
. SPP Motification 5... Provides So... Manua Properties
. SSDP Discovery Discovers n... Started Manua 7
", Extended / Standard / Help
Stop service Sentinel LDK License Manager on Local Computer

made to ceatz BIEIRININA




H ASP E( vovsS: 2 € rtcrma Eror: HasP AP eturmed (4

oK

—HASP Error: Internal HASP Error: HASP
APl Returned (64)

- Click on link:
http://localhost:1947/ int /ACC help index.html

- Delete cloned key

- Stop/start Sentinel LDK License Manager service
- Will use an activation; can be added back

- Submit a ticket to bernina.com/help

................................................................ made to creale BERNINA
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http://localhost:1947/_int_/ACC_help_index.html

HASP Ervovs: 3

—~HASP Error: already burned
- Use same link as previous slide

@ HASP_ACT ORDER ALREADY BUREMED

O

- Remove cloned key

- Stop and start Sentinel LDK License
Manager service

- Does use an activation; can be added back
- Submit a ticket to bernina.com/help
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Resta rting VCS

Design fails to send to machine with Direct

Connect

= Type In search:
Services

=Locate Universal
Communication
Server

—~>May have to start
or stop & start

i UPnP Device Host
o User Profile Service
~ Virtual Disk

i Volume Shadow C...

“; WebClient
: Windows Activati...
++ Windows Audio

. Windows Audio E...

" Windows Backup

“; Windows Biometri...

Universal Commu...

Allows UPn...

This service ...

Provides m...

Manages an...
Enables Win...

Performs W...

Manages au...
Manages au...

Provides Wi...
The Windo...

\ Extended /(Standard /

Started Automatic

Start
Stop
Pause
Resume

Restart

All Tasks »
Refresh

Properties

Help

27 Services . - - = | B |
File Action View Help
e @U@ > 80w
. Services (Local) </ Services (Local)
Universal Communication Server MName Description Status Startup Type logOnAs =
_ “; Tablet PCInput 5e... Enables Tab... Manual Local Syste...
Stop the service o Task Scheduler Enables a us.. Started Automatic Local Syste...
Restart the service . ) A )
. TCP/IP MetBIOS H... Provides su.. Started Automatic Local Service
 TeamViewer12 TeamViewe... Started Automatic Local Syste...
BE_SC”F't'|°g: ations S ~: TechSmith Uploa... TechSmith.. Started Automatic Local Syste...
niversal Communications Server to i Telephony Provides Tel... Manual MNetwork 5...
communicate with sewing machines
w: Themes Provides us...  Started Automatic Local Syste...
~: Thread Ordering 5... Provides or... Manual Local Service
. TPM Base Services  Enables acc... Manual Local Service
i UMVPFSry UMVPFisa .. Local Syste..

Local Service
Local Syste...
Local Syste...
Local Syste...
Local Service
Local Syste... |5
Local Service
Local Syste...
Local Syste...

Local Syste.. =
2
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Connecting +o 200/730

—=>Direct connect with
200/730

—>Submit a ticket to
bernina.com/help

wote vy BERNINA

ESTASLIZHING CONNECTIVITY WITH THE 200/730 after CREATORS
UPDATE

1. Start admin/Power Shell or a command

prompt as administrator.
Right cick on start, select Windows Power
Shel (Admin) -OR-

Enfter omd In the search box; then right cick
and zelect Run as Administrator.

- o
Do
B Ao cdm it
oo

3. Adiaiog box shows,; then enter these bwo Iines: (you can copy by high-
ighting the two Iines below with Cirl +C; then cick In the biue box and
select Crl + V o paste the lines)

REG ADD HIASY S TEMCUTet Contatel SerdondiapiVpr & SvchontSpitOimtie A

REG_DWORD S 1 £

REG ADO HILMEY S TENMCuTent ContatiefSarionsiWonaCorm iy Svchom Spit Dmtie A

REG_DWORD K | £

4. Restart computer and Windows Device Canter wil work.
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Submitting a Ticket

BERNINA HELP CENTER
—bernina.com/help

—Enter the information Software Support
requested

3

BERMIMNA Help Center = Submit a request

SUBMIT A REQUEST

Please choose your izsue below

Technical Software Support

Your email address *

................................................................................................. made to creale BERNINA



Release Notes

AWI II be pOSted BERNINA Embroidery Software 8
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License Tvansfor
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License Tvansfer

—~>Moves the software from one pc to another
- Do not need product key
- Do not need Internet Connection
- Doesn’t use an activation
- Old PC must be working

—>RUS tool is included with the install of full
version of V8.0T R2

................................................................ made to creale BERNINA
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License Transfer: Copy to USE

—~>Navigate to the License Transfer folder
—Open BES V8 Transfer Activation
—>Print pages for instructions (PDF file)

—~Copy the RUS Bernina_V8 to USB stick
TR0 OO

P - - -
@-u-v| ; ¥ Downloads » W80T Full version » LicenseTransfer

Organize - B8 Open with Adobe Acrobat Reader DC Share with = Print E-mail Burn Mew folder
r Favorites Mame Date maodified Type Size
Bl Desktop ™. BES V& Transfer Activation DE 10/16/2017 414 PM Adobe Acrobat D... 627 KB
4. Downloads = s #wation 10/16/2017 4:14 PM  Adobe Acrobat D... 623 KB
% iCloud Photos 10/16/2017 4:14 PM  Application 14323 KB
| Recent Places



License Tvansfev: New PC

—Install software on new PC

—~>Reboot computer to complete the install
—~DO NOT RUN software yet

—Don’t enter Product Key
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License Tvansfev: New PC

->Place USB in computer

-Run RUS program from e ———ns—
USB stick (double click) L e

SSelect Transfer License Tab | oo e =

Colect information sbout the recipient computer

-Name file in white area A

- Select Browse; select USB

—Click Collect & Save Info

—~Creates an ID file on USB ST =

Generate the license transfer file to |

................................................................................................. made to creale BERNINA



License Tvansfer:

—>Confirmation message

—C

ose RUS program

—Eject USB

o

New PC

&

Colect Status Information | Apply License Fle  Transfer License |

To transfer (rehost) a license from one computer 1o another, you run the RUS program on both
computers. On each computer, select the Transfer License tab and perform the appropriate step.

Collect information about the recpient computer

Step 1: On the computer to which you want to transfer the kcense (the “recipient computer”),
collect and save information about the computer.

Collect and Save Information I

Save recipent nformation to lD:,vNe:\ oC.ud

0“ The recipient information is stored in the file D:/New PC.id.

Ensure that this file (or a copy of this file) is accessible on the computer that
currently contains the license.

ok |

Read the recipent nformation file from I

Generate the lcense transfer fie to I

e
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License Transfer: Old PC/E@&

- RUS

P —

| Collect Status Information Apply Liceﬂse File | Transfer Licensb

To transfer {rehost) a license from one cnmpﬁﬂy\torin'zz'uer, ycy_Lun—H'ﬁUS program on both

computers. On each computer, select the Transferticense tab and perform the appropriate step.

—Close software

Step 1: On the computer to which you want to transfer the license (the “recipient computer™),
collect and save information about the computer,

_§I n S e rt LJ S B Save recipient information to — \_|
SRun RUS from USB | ==

at currently contains the license (the “source @
se to transfer, read the recipient information file and generate a license transfer
LI tab

—>Select existing key
—Click on Browse —,

Read the redpient information file from

(I ower r| g ht corne r) Generate theicense ansfer i o

Key ID Products

st-AdminMode | NS Gernin Designer

|Generate License Transfer Filel
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License Tvansfer: Old PC

- v = Drive Tools  KINGSTON (Dx) _ o %
—>Browse to USB .
d modified

« “* P o » ThisPC » KINGSTON (Dx)

& Downloads al [

—~Select ID file you | ‘n

= Pictures

5 Series BLC

created
—>Open
—Click Yes to S

confirm moving
license key




License Tvansfer: Old PC

25 pus =RRCE X

Collect Status Information Apply License File Transfer License |

To transfer (rehost) a license from one computer to another, you run the RUS program on both
computers. On each computer, select the Transfer License tab and perform the appropriate step.

—>Specify name for

Step 1: On the computer to which you want to transfer the license (the “recipient computer™),
collect and save information about the computer,

License Transfer File =

R

Collect and Save T -
Lollect and save 1

(New PC License

Step 2: On the computer that currently contains the license (the "source computer”), select

T f h 2 h the license to transfer, read the recipient information file and generate a license transfer file.
rans e r " Key Type Key ID Products

st-AdminMode | NS Gernin Designer
—Click on Browse

—Save to the USB
stick

w

=Click OK e s
—=Saved file 1Is on USB :

|Generate License Transfer Filel
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License Tvansfer

—=License Transfer File on USB

¥ Select the file to apply x

4 = * KINGSTON (D:) v & | Search KINGSTOM (L o

Organize v Mew folder =« T 8

) s .
1ame Lrate modried Ve
OneDrve p

B This pC | License Transfer.h2h W0/3/ 2007 10:58 AM H2H File

Bl Desktop

=| Drocuments
¥ Downloads

b Music

= Pictures

B videos

= 0500

o= KINGSTON (D:)

— KINGSTON (D:)

L 4 >

File name: | License Transfer.h2h | All supported files (*.h2r "w2c ™
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License Tvansfev: New PC

—~Plug in USB — e ———
—~Run RUS from USB

stick s @

—Click on Apply
License File tab

—Click on Browse

# Select the file to apply X
%SeleCt h2h file 4 o+ KINGSTOM (D:) w & Search KINGSTOM ([ o
) Organize « Mew folder =+ T @
—50 OneDrive " gl . Date modiie a
en
p & This PC
Bl Decltnn

0000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000



License Tvansfer

—Click on Apply Update
to confirm transfer

—>Confirmation message

—Close RUS

—Run software on new

PC

OCCOCCOOCOCCOOOOOCOOOCOCTCOOOOCCOOCOOTCOCOOOCOOCOOOOOOL

O
Colect Status Information Apply Licensa | Transfer License
R
E- _host
redpient_hostDESKTOP-Q3SDLKD
ehast_time  Tue Oct 3, 14:57:15 UT
112801
id 112801
hasp H05T02BE035 1969312
02:
ng update from file D: \License Transter.h2h
pdate written swocessfully
made to creale BERN I NA




Copy Fall Vevsion

== * Computer » USE DISK () »

Organize v Share with » Burn Mew folder
45 Favorites Name : Date modified Type
Ml Desktop . ActiveSync 10/26/201711:31 ... File folder
4 Downloads ) Corel 10/26/201711:31 ... File folder
% iCloud Photos J I5SetupPrerequisites 10/26/201711:31 ... File folder
=] Recent Places J LicenseTransfer 10/26/201711:31 ... File folder
=/ Pictures . Microsoft 10/26/201711:31 ... File folder
[ | Support 10/26/201711:31 ... File folder
%Ve rs I O n O K 4 Libraries | User Manual 10/26/201711:31 ... File folder
> 3 Documents . Win32 10/26/201711:31 ... File folder
> ¥ Embroidery ) whd 10/26/201711:31 ... File folder
> J’ Music 4 0x040a 6/21/201011:31 PM  Configuration s
> || Pictures 4 | 0x040c 6/21/201011:35 PM  Configuration s
> B8 Videos 4 | 0x041d 6/21/201011:47 PM  Configuration s
| 0x0dle 6/21/201011:48 PM  Configuration s
> ¥ Homegroup 2 00404 8/8/201111:57 PM  Configuration s
4 | 00406 6/21/201011:29 PM  Configuration s
4 M Computer 4 00407 3/15/201211:50 PM  Configuration s
o a 05 (C) 2 00409 3/23/2010 1:44 AM - Configuration s
> &) CD Drive (F:) HP Launcher 4 | 00410 6/21/201011:37 PM  Configuration s
- > @ HP SirmpleSave (G:) 4 0x0411 3/15/2012 9:55 PM Configuration s
> 3 CD Drive (H:) Bernina_V8.0K 4 | 00412 4/2/2012 11:44 PM Configuration s
> N eW fu | I Ve rS I O n I oy USB DISK (I:) ) 00413 6/21/201011:39 PM  Configuration s
4 0x0414 6/21/201011:39 PM  Configuration s
4 ‘?j Metwork i | 0x0415 3/16/201212:57 AM  Configuration s
> 8 DLASHBROOK % 0416 6/21/2010 11:40 PM  Configuration s
| 0x0419 6/21/201011:43 PM  Configuration s
4 | autorun 4/13/2017 2:40 AM  Setup Informati
j datal 10/26/201710:41 ... Cabinet File
Aatal helr 106401 T 1041 HINR Fil=
36 items
-
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Questions about Activations?

—>Contact Software Support

—SS contacts Wilcom who can issue
additional activations
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Release Notes
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